
iWorx Physiology Lab Experiment

iWorx Systems, Inc.

www.iworx.com

iWorx Systems, Inc. 

62 Littleworth Road, Dover, New Hampshire 03820

(T) 800-234-1757 / 603-742-2492 (F) 603-742-2455

LabScribe2 is a trademark of iWorx Systems, Inc. 

©2013 iWorx Systems, Inc.

Experiment HH-1

The Electrocardiogram and

Peripheral Circulation

Note: The lab presented here is intended for evaluation
purposes only. iWorx users should refer to the User
Area on www.iworx.com for the most current versions of
labs and LabScribe2 Software.



Experiment HH-1: The Electrocardiogram and Peripheral Circulation

Background

The cardiac cycle involves the sequential contractions of the atria and the ventricles which are triggered 

by action potentials in the myocardial cells. The combined electrical activity of the myocardial cells 

produces electrical currents that spread through the body fluids. These currents are large and detectable 

by recording through electrodes placed on the skin. The regular pattern of signals produced by the heart 

is called the electrocardiogram or ECG (Figure HH-1-B1).

Figure HH-1-B1: ECG recording displayed in the Main window with labels showing the P, QRS, and T 

waves. 

The components of the ECG are correlated to electrical activity in the atria and ventricles such that:

• Atrial depolarization produces the P wave.

• Atrial repolarization and ventricular depolarization produce the QRS complex.

• Ventricular repolarization produces the T wave.

The depolarization of the myocardial cells in the ventricle causes the ventricles to contract and force 

blood into the major arteries of the circulatory system in a pulsatile manner. The pulses of blood 

moving in arteries can be recorded using a device known as a plethysmograph. 

In this experiment, you will record a single lead ECG and the pulse wave in the finger of a subject 

simultaneously. This exercise will demonstrate the time delay that occurs between the electrical events 

in the heart and mechanical events in the circulatory system. You will also examine the effects of 

temperature on peripheral circulation.

Human Heart – ECG and Circulation – Background HH-1-1



Experiment HH-1: The Electrocardiogram and Peripheral Circulation

Equipment Required

PC or Mac Computer

IXTA data acquisition unit

USB cable

IXTA power supply

C-ISO-B3G ECG cable and electrode lead wires

PT-104 Pulse plethysmograph

Stethoscope

Alcohol swabs

Disposable ECG electrodes

Ice, cold and hot water, plastic bags

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power 

socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to 

turn on the unit. Confirm that the red power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv4.iwxgrp. Select this group and click 

Open.

4. Pull down the Settings menu again. Select the ECG-Circulation-LS2 settings file in Human 

Heart.

5. After a short time, LabScribe will appear on the computer screen as configured by the ECG-

Circulation-LS2 settings.
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6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are programmed on the Preferences Dialog window which can be viewed by 

selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

ECG Cable and Pulse Transducer Setup

1. Locate the PT-104 pulse plethysmograph (Figure HH-1-S1) and C-ISO-B3G ECG cable and 

electrode lead wires (Figure HH-1-S2) in the iWorx kit.

Figure HH-1-S1: The PT-104 pulse plethysmograph.

2. Plug the DIN8 connector to the PT-104 into the Channel A5 input of the IXTA (Figure HH-1-

S3).

3. Insert the connector on the end of the C-ISO-B3G ECG cable into the iWire 1 input on the front 

of the IXTA.

4. Insert the connectors on the red, black, and green electrode lead wires into the matching sockets 

on the ECG cable.

5. Instruct the subject to remove all jewelry from their wrists and ankles.  Another option is to use 

the area just under each clavicle which will give a better recording.

6. Use an alcohol swab to clean and scrub a region with little or no hair, on the inside of the 

subject’s right wrist/clavicle. Let the area dry.

7. Remove a disposable ECG electrode from its plastic shield, and apply the electrode to the 

scrubbed area on the wrist.
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8. Repeat Steps 6 and 7 for the inside of the left wrist/clavicle and the inside of the right ankle.

Figure HH-1-S2: The C-ISO-B3G ECG cable with three lead wires attached.

Figure HH-1-S3: The ECG cable and pulse transducer connected to an IXTA.

9. Snap the lead wires onto the electrodes, so that:

• the red (+1) lead is attached to the left wrist or just under the left clavicle,

• the black (-1) lead is connected to the right wrist or just udner the right clavicle,

• the green (C or ground) lead is connected to the right leg or on the abdomen.

10. Place the plethysmograph on the volar surface (where the fingerprints are located) of the distal 

segment of the subject’s middle finger or thumb, and wrap the Velcrotm strap around the end of 

the finger to attach the unit firmly in place.
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11. Instruct the subject to sit quietly with their hands in their lap. If the subject moves, the ECG 

trace will move off the top or bottom of the screen. If the subject moves any muscles in the 

arms or upper body, electromyograms (EMGs) from the muscles will appear on the ECG 

recording as noise.
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Experiment HH-1: The Electrocardiogram and Peripheral Circulation

Exercise 1: The ECG and the Pulse in a Resting Subject

Aim: To measure and correlate the ECG and the pulse in a resting individual.

Procedure

1. Click on the Record button, located on the upper right side of the LabScribe Main window 

(Figure HH-1-L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the iWorx unit and 

computer, an error window will appear in the center of the Main window. Make sure the iWorx unit is 

turned on and connected to the USB port of the computer. Click OK and select the Find Hardware 

function from the LabScribe Tools menu. 

2. Click on the AutoScale button at the upper margin of the ECG, Pulse, and Pulse Integral 

channels. Your recording should look like Figure HH-1-L2. 

• If the signal on either the ECG or the Pulse channel is upside down when compared to 

trace, click on the downward arrow to the left of the channel title and select the Invert 

function. The trace should now look similar to the one in the figure

• If a larger ECG signal is required, the electrodes should be moved from the wrists to 

the skin immediately below each clavicle. 

• If the pulse signal is small or noisy, adjust the tension on the strap holding the pulse 

plethysmograph to the finger.

3. When you have a suitable trace, type <Subject’s Name> Resting ECG/Pulse in the Mark box to 

the right of the Mark button. Press the Enter key on the keyboard to attach the comment to the 

data. Record for a minute or two.

4. Click Stop to halt recording. 

Figure HH-1-L1: The LabScribe toolbar.
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Figure HH-1-L2: ECG, pulse, and pulse integral displayed on the Main window. The arrow is placed 

above a dichrotic notch.

5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, (like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.

Data Analysis 

1. Scroll through the recording and find a section of data with five or six exemplary ECG/pulse 

cycles in succession.

2. Use the Display Time icons to adjust the Display Time of the Main window to show at least 

four complete ECG/Pulse cycles on the Main window. Four adjacent ECG/Pulse cycles can also 

be selected by:

• Placing the cursors on either side of a group of four complete ECG/Pulse cycles.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 

segment with the four selected ECG/Pulse cycles to the width of the Main window.

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window.
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4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 

window. The names of the mathematical functions used in the analysis, V2-V1 and T2-T1, 

appear in this table. The values for V2-V1 and T2-T1 from each channel are seen in the table 

across the top margin of each channel. In this exercise will only need to record the values for 

T2-T1.

5. Once the cursors are placed in the correct positions for determining the time intervals on each 

ECG/Pulse cycle, the values of the time intervals can be recorded in the on-line notebook of 

LabScribe by typing their names and values directly into the Journal, or on a separate data table.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter 

the names and values of the parameters from the recording to the Journal. To use these 

functions:

• Place the cursors at the locations used to measure the amplitudes and period of the 

ECG/Pulse cycle.

• Transfer the names of the mathematical functions used to determine the amplitudes and 

time interval to the Journal using the Add Title to Journal function in the ECG Channel 

pull-down menu.

• Transfer the values for the amplitudes and beat period to the Journal using the Add Ch. 

Data to Journal function in the ECG Channel pull-down menu.

Figure HH-1-L3: ECG, pulse and pulse integral displayed on the Analysis window with cursors in 

place to measure the R-Pulse interval with the T2-T1 function.
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7. Use the mouse to click on and drag the cursors to specific points on the ECG/Pulse recording to 

measure the following:

• The beat period, which is the time interval between two adjacent R waves. To measure 

the beat period, place one cursor on the peak of an R wave and the second cursor on the 

peak of the adjacent R wave. The value for T2-T1 on the ECG channel is the beat 

period. Measure the beat period for two additional pairs of R waves. 

• The R-Pulse interval, which is the time interval between the peak of the R wave and the 

peak of the pulse wave that follows the R wave. To measure this interval, place one 

cursor on the peak of an R wave and the second cursor on the peak of the pulse wave to 

its right. The value for T2-T1 on any channel is this interval. Measure this interval for 

two additional ECG/Pulse cycles.

8. Calculate the following values and record your results into the Journal or on a separate data 

table:

• The average beat period, in seconds/beat.

• The heart rate, which is expressed in beats per minute and calculated from the average 

beat period by using the following equation:

• Heart Rate (beats/minute) = 60 seconds/minute

• # seconds/beat

• The average R-Pulse interval.

Questions

1. What electrical and mechanical events take place during the R wave?

2. What events take place in the cardiovascular system during the R and pulse waves?

3. The signal recorded on the Pulse channel is rate of change of the blood pressure entering the 

subject’s finger tip. When this signal is integrated, the waveform displayed on Pulse Integral 

channel is similar to an arterial pressure curve. Is there a short plateau or dip during each cycle 

displayed on the Pulse Integral channel? This plateau or dip is called the dichrotic notch. If you 

optimized the tension on the plethysmograph strap to record a large, clean pulse wave from 

your subject, you should see a dichrotic notch on the Pulse Integral channel.

4. What event recorded on the Pulse channel corresponds to the dichrotic notch? What causes a 

dichrotic notch?

Exercise 2: The ECG and the Pulse in Other Subjects

Aim: To measure and correlate the ECG and the pulse in other subjects.

Procedure

Repeat Exercise 1 on other subjects. 
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Data Analysis 

Analyze the data for each subject using the same techniques used in Exercise 1.

Questions

1. Is the time interval between the R wave and the peak of the pulse wave the same for each 

subject? Does this time interval differ with heart rate?

2. Do you see any differences in the size or shape of dichrotic notches from different subjects? 

Remember: the tension on the plethysmograph strap affects the shape of the pulse recording.

3. Is the time interval between the peak of the pulse wave and the bottom of the dichrotic notch the 

same for each subject?

4. What factors would affect the shape or position of the dichrotic notch?

Exercise 3: The Effect of Cold on the Pulse

Aim: To measure the effects of cold on the pulse and heart rate.

Procedure

1. Attach the plethysmograph to the middle finger of the subject’s left hand. Instruct the subject to 

sit quietly with their hands in their lap.

2. Click on the Record button. The signal should begin scrolling across the screen.

3. Click on the AutoScale button at the upper margin of the ECG, Pulse, and Pulse Integral 

channels. Your recording should look like Figure HH-1-L4. Use the same techniques used in 

Exercise 1 to display the signals properly.

4. When you have a suitable trace, type <Subject’s Name> RoomTempECG/Pulse in the Mark box 

to the right of the Mark button. Press the Enter key on the keyboard to attach the comment to 

the data. Record for a minute or two.

5. Type Cold ECG/Pulse in the Mark box to the right of the Mark button. Place a bag containing a 

mixture of ice and cold water on the subject’s left forearm. At the same time, press the Enter 

key on the keyboard to attach the comment to the data. Record for two minutes while the cold 

pack is on the subject’s forearm.

6. Type Remove in the Mark box. Simultaneously remove the ice bag and press the Enter key on 

the keyboard.

7. Record for an additional two minutes; then, click Stop to halt recording.

8. Select Save in the File menu on the LabScribe window.

Data Analysis

1. Scroll through the recording and find a section of data with four or five exemplary ECG/Pulse 

cycles, in succession, that were recorded at room temperature.

2. Use the Display Time icons, or the cursors and the Zoom between Cursors button, to adjust the 
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Display Time of the Main window to show at least four complete ECG/Pulse cycles on the 

Main window.

3. Click on the Analysis window icon in the toolbar to transfer the data displayed in the Main 

window to the Analysis window.

4. Look at the Function Table in the Analysis window and make sure the mathematical functions 

used in the analysis, V2-V1 and T2-T1, appear.

5. Once the cursors are placed in the correct positions for determining the amplitude and time 

intervals, transfer the names and values of the parameters measured in the Analysis window to 

the Journal using one of the two techniques described in Exercises 1, or transfer the values to a 

separate data table.

Figure HH-1-L4: ECG, pulse and pulse integral displayed on the Analysis window with cursors in 

place to measure the pulse amplitude with V2-V1 function.

6. Use the mouse to click on and drag the cursors to specific points on the ECG/Pulse recording to 

measure the following:

• The pulse wave amplitude. To measure the pulse wave amplitude, place one cursor on 

the baseline that precedes the pulse wave and the second cursor on the peak of the pulse 

wave. The value for V2-V1 on the Pulse channel is this amplitude. Determine the pulse 

amplitude for three pulse waves.

• The beat period. Measure the time between two adjacent R waves using the same 

technique employed in Exercises 1 and 2. Determine the beat period for three. 

ECG/Pulse cycles.
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• The R-Pulse interval. Measure the time between the peak of the R wave and the peak of 

the pulse wave using the same technique employed in Exercises 1 and 2. Determine this 

interval for three ECG/Pulse cycles.

7. Repeat Steps 5 and 6 for the data at 1 and 2 minutes into the cooling period, and at 1 and 2 

minutes into the rewarming period

8. Calculate the following values and type your results into the Journal or on a separate data table:

• The average pulse wave amplitude while the forearm was at room temperature, cooled 

for 1 and 2 minutes, or rewarmed for 1 and 2 minutes.

• The heart rate while the forearm was at room temperature, cooled for 1 and 2 minutes, or 

rewarmed for 1 and 2 minutes.

• The average R-Pulse interval while the forearm was at room temperature, cooled for 1 

and 2 minutes, or rewarmed for 1 and 2 minutes.

Questions

1. What effect does cooling have on the amplitude of the pulse wave? 

2. Does cooling of the forearm affect the heart rate, or the time interval between the R wave and 

the peak of the pulse wave?

3. Through what mechanism does cooling affect the peripheral circulation?

4. What other factors may affect peripheral circulation?

Exercise 4: The Effect of Heat on the Pulse

Aim: To measure the effects of heat on the pulse and heart rate.

Procedure

1. Move the plethysmograph to the middle finger or thumb of the subject’s right hand.

2. Follow the directions used in Exercise 3 to do an experiment on the right forearm of the subject 

with a bag of warm water. Mark the recording to indicate when the bag of warm water was 

applied and removed from the forearm.

Questions

1. What effect does warming have on the amplitude of the pulse wave? 

2. Does warming of the forearm affect the heart rate, or the time interval between the R wave and 

the peak of the pulse wave?

3. Through what mechanism does warming affect the peripheral circulation?
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